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COPYRIGHT INFORMATION 
The information in this documentation is subject to change without notice and does not represent 
any commitment on behalf of DIGIOP Technologies (“DIGIOP”). DIGIOP disclaims any liability 
whatsoever for incorrect data that may appear in this documentation. The product(s) described in 
this documentation are furnished subject to a license and may only be used in accordance with 
the terms and conditions of such license. 
 
Dell is a registered trademark of Dell Inc. 
Microsoft, Windows, and VISTA are registered trademarks of Microsoft Corporation in the United 
States and other countries. 
Western Digital is a registered trademark of WD in the United States and other countries. 
All other trademarks and copyrights are the property of their respective owners and provided 
under license. 
 
The documentation is issued in strict confidence and is to be used only for the purposes for which 
it is supplied. It may not be reproduced in whole or in part, in any form, or by any means or be 
used for any other purpose without prior written consent of DIGIOP and then only on the condition 
that this notice is included in any such reproduction. No information as to the contents or subject 
matter of this documentation, or any part thereof, or arising directly or indirectly therefrom, shall 
be given orally or in writing or shall be communicated in any manner whatsoever to any third 
party being an individual, firm, or company or any employee thereof without the prior written 
consent of DIGIOP. Use of this product is subject to acceptance of the DIGIOP license 
agreement required to use this product. DIGIOP reserves the right to make changes to its 
products as circumstances may warrant, without notice. 
THIS DOCUMENTATION IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING THE WARRANTIES OF TITLE, NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, INTEGRATION, 
PERFORMANCE AND ACCURACY, AND ANY IMPLIED WARRANTIES ARISING FROM 
STATUTE, COURSE OF DEALING, COURSE OF PERFORMANCE OR USAGE OF TRADE. 
Please send any comments regarding the documentation to documentation@digiop.com. 
Find out more about DIGIOP at http://www.digiop.com 
 
© 2008 by DIGIOP Technologies, LTD. All Rights Reserved. DIGIOP is a registered trademark 
and the DIGIOP logo and Enterprise Surveillance Portal (ESP) are trademarks of DIGIOP 
Technologies.  September, 2008 P/N GDE_G3_User_09-08. 
 
 
This user guide provides usage and background information for the DIGIOP G3 Recorder. The 
documentation is available as a PDF file on the DIGIOP website at www.digiop.com  
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About This Guide 
 
WARNING: Text set off in this way indicates that failure to follow directions in the 
warning could result in bodily harm or loss of life. 

 

CAUTION: This symbol indicates that failure to follow directions in the Caution could 
result in damage to the equipment or loss of information. Important operating and 
maintenance instructions are included in the literature with this unit. 
 
IMPORTANT: Text set off in this way presents information or instructions that should 
be followed or information of particular interest. 
 

NOTE: Text set off in this way presents information or instructions. 
 

Safety and Regulatory Information 
 

For safety information, see the DIGIOP Safety Guide packaged with your product or go 
to the support page of the DIGIOP website at www.digiop.com/support  

For regulatory information, see the Dell Regulatory Notices insert provided with your 
system. 

 
 
IMPORTANT: This installation should be performed only by a qualified service person; it should 
conform to all municipal codes. 
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Introduction to Digital Video Recording 
Rapid economic growth and commercial sophistication in recent years has made 
protection of major facilities and intellectual property a critical issue for businesses and 
individuals. The demand for the centralized management of security systems and 
controls, as well as protection of property from fire hazards and other natural disasters, 
using remote surveillance systems, is growing at an accelerating rate. 
 
This guide is intended for administrators, service providers, installers, and others who set 
up and configure the DIGIOP® Technologies LTD system. 
 

Features 
• Records and stores digital images for longer periods of time than competitive 

technologies  
• Produces four times the efficiency of conventional compression methods through the 

use of an enhanced MPEG-format, file-compression algorithm  
• Innovative Enhanced MPEG Compression Technology — Previously, only Motion-

JPEG or MPEG were used. The Motion-JPEG has a disadvantage of having large 
image files, so the image blurs with a lot of movement. DIGIOP improves both 
compression and image quality by making use of enhanced MPEG formats. 

• DIGIOP provides Triplex on Remote — The main digital security functions are: 
• Image recording 
• Multiplexing 
• Data transmission for remote surveillance 

• Highly reliable, maintenance-free digital security system — Eliminates the 
disadvantages of stored videotape images, which are often distorted from prolonged 
use, making the production of clear still images virtually impossible. DIGIOP stores 
digital images on the hard drive resulting in clear, printed still images. Digital storage 
reduces maintenance costs by continuously recording images on the same drive.  

• Fully-compatible with existing CCTV cameras and equipment with NTSC or PAL 
signals, which helps eliminate the costs for replacing existing VCR, multiplexer, or 
other hardware. 

• Includes high-speed search functions, recorded data manipulation, post-recording 
image enhancement, and Smart-Search as standard features across all commercial 
DIGIOP systems. 

• Records up to 32 CCTV cameras at the same time with expandable hard disk 
capacity, allows recording of multiple channel images for longer periods 

• Uses proprietary image authentication that prevents recorded images from being 
manipulated and changed. Conventional systems, on the other hand, typically use a 
storage method that does not prevent access and manipulation of stored data. 

• Proprietary encryption ensures that video is authentic for file protection and forensic 
purposes. Images can only be viewed using the DIGIOP decoder in DIGIOP Viewers 
or the DIGIOP plug-in for the Microsoft® Windows® Media Player. Images can also 
be converted to other standard video formats. 
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Real-time image transmission through the Internet—DIGIOP uses a unique, enhanced, 
and encrypted MPEG compression algorithm and supplies the DIGIOP “Remote 
Manager” software to transmit encrypted, real-time images through the Local Area 
Network or over the Internet. 

What is DIGIOP Remote Manager? 
(Provided with all DIGIOP systems) A DIGIOP-developed, client-based, remote 
surveillance software application that lets you monitor DIGIOP camera images 
from a number of remotely located DIGIOP systems using TCP/IP transmissions. 
You have full access to camera and system-wide setup without having to be at the 
system location. This provides centralized monitoring and flexibility/mobility. 
Remote Manager lets you view up to 24 individual camera images at a time, pick 
and choose which cameras are to be displayed, where onscreen they are displayed, 
and connect and disconnect cameras from view.  

What is DIGIOP Enterprise Surveillance Portal (ESP)?  
(Provided with all DIGIOP systems Series 7 Software) This DIGIOP-developed, 
web-based, surveillance application lets you manage DIGIOP systems and IP 
devices remotely using TCP/IP transmission. Like the Remote Manager, ESP 
allows full access to camera and system set-up without having to be at the system 
location and provides centralized monitoring and flexibility. ESP lets you view up 
to 36 camera images at a time, pick and choose which cameras are to be 
displayed, where onscreen they are displayed, and connect and disconnect 
cameras from view. 
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Unpacking the contents 
The following items are included with your DIGIOP system. If any of these are missing 
or damaged, notify your DIGIOP Dealer immediately. Keep the packaging for 
transportation or storage: 
 
• Mouse (standard USB) 
• Keyboard 
• Video input cables (except on the DIGIOP S30) 
• Power cord 
• PTZ control cable (on some systems) 
• PTZ RS-232 cable (on some systems) 
• VGA/DVI monitor splitter cable (on some systems) 
• DIGIOP Recovery DVD 
• DIGIOP Client CD 
• Nero® CD 
• Quick Start Guide 
• Surge protection and anti-virus warning document 
 
 

Tower system 

Rack mount system Desktop system 

Dell T-3400 
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Installing the hardware 
DIGIOP camera, audio, and other inputs are generally built into the back of the system. 
However, they may also be comprised of flexible, multi-connection cables terminated 
with a multi-pin DIN plug and BNC connectors. Table 1 describes the system ports and 
connectors. 
 
CAUTION: Multi-connection cables come in many varieties and are typically suited to a specific 
DIGIOP system model. 
• When installing these cables, be very careful not to bend the interconnecting pins on the 

cable plug and system.  
• Do not pull or place undue stress on the cables or connectors when installing or 

disconnecting any cables. Make sure the cables are long enough so they do not create cable 
tension when connected to the system.  

• Multi-connection cables may include both video and audio inputs. The connectors are 
labelled V = Video or A = Audio.  

• Do not plug video sources into audio inputs or vice versa. 
 

Table 1. 
System ports and connectors 

 
NOTE: This example shows main components only. Components may vary between models. See the Quick 
Start Guide that came with your system for more complete information. 

  Component Description 

 

Network link LED Displays a network connection.  

 

Diagnostic LEDs Display various statuses of the unit. See the DIGIOP G3 Service Guide for 
descriptions of the diagnostic LEDs.   

1 

2 
3 
4 

7

5 

8

9

11 
12 

10 

13 

14 

15 

18 

19 

20 

16 

26 17 

21 
22 

24 

25 

6 23 

1 

2 
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Headphone/ 
Microphone jacks 

Not used 

 

Power button &  
Power LED 

Powers the system on and off. To manually turn power off, press and hold the 
button for at least 10 seconds. A System Shutdown message is displayed and 
the system shuts down. May be also used as described in case of abnormal 
system operation. 

IMPORTANT: The DIGIOP auto-recovery restores the system with the last system backup. Before powering 
down the system or after each system change, back your system up.This ensures that the system is restored 
with the most current configuration and settings. 

WARNING: Before connecting the power, double check that the power switch (AC110V ~ 120V ->115, 
AC220V~240V->230V) is switched to 115VAC. 

 

DVD-RW slot Media slot for the DVD/CD  

 

Hard drive activity 
LED 

Displays activity on the HDD 

 

USB port Connects exterior USB interface devices including hard drives, CDRW, 
memory stick adapters, etc.  

 

Line in Not used 

 

Speaker out (Optional; only if equipped for audio) Connects to a “line level” amplified device 
or amplified speaker 

 

Local Area 
Network (LAN) 
port (RJ-45) 

(For remote monitoring) Connects an Ethernet LAN, Internet, or exclusive-line, 
TCP/IP-based 10/100/1000Base-TX Ethernet to the DIGIOP system.  

 

PC Monitor output Connects a standard VGA-type monitor. For best viewing, we recommend a 
17" or larger monitor (for 4- to 16-camera installations) or a 19" monitor (for 32-
camera installations) 

Sensor Inputs/Relay Outputs (Optional when Sensor/Relays are used) — 
Connects sensor inputs to the DIGIOP system, for example, external alarm 
devices can be made directly to this I/O board.    

I/O Board 

PTZ Controller (see the Quick Start Guide for diagrams) — Connects a PTZ 
controller to the I/O board. Most PTZs use RS-422 or RS-485 connectors. Use 
the supplied cables and follow the instructions in the documentation that came 
with the PTZ controller. 

 

Audio In  
(See also 25) 

(location and operation vary with model; see the Quick Start Guide for 
diagrams) Most camera/audio inputs use a multi-pin, sub-D connector with 
“flying” leads and pre-terminated connectors. The plugs are typically marked 
“V” for video/camera connections and “A” for audio inputs. For 16- and 32-
channel systems, you need two or more sets of cables (not provided). 

 

Spot Monitor 
Output(s) 

(Not on S240) Connects an analog CCTV monitor to the RCA “spot out” jack. 
The spot monitor screen layout is always the same as the PC layout. For some 
systems, an output is not supplied; you can install an option card for viewing. 

5-6 

7 

3-4 

8 

12 

13 

16 

10 

9 

11 

15 

14 
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Video In  
(Camera inputs) 
(See also 
connector 26) 

Same as Audio In (15) 

 

Power plug Connect the provided  power cord 

 

Voltage Selector Lets you set the voltage on the unit (110VAC to 220VAC). Make sure the unit is 
set to 110VAC before connecting it to external power. 

 

USB port (2) Connects exterior USB interface devices including hard drives, CDRW, 
memory stick adapters, etc.  

 

Mouse port Connects the provided mouse or a Windows-compatible mouse to the system 

 

PS2 keyboard port Connects the provided keyboard 

 

Graphics adapter  VGA or DVI connector (required) 

 

Audio In Same as Audio In (15) 

 

Video In  
(Camera inputs) 
(See also 
connector 17) 

Same as Audio In (15) 

 

24 

18 

19 

20 

23 

22 

17 

25 

26 
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About the installed DIGIOP Server software 
As a standard package, DIGIOP systems come with the DIGIOP Server software already 
installed.  This includes the basic application to view live and archived video, configure 
users, etc. 
 
IMPORTANT: Ensure that the version numbers of each piece of software are compatible. 
Incompatibility may result in less than optimal performance. For information about software 
versions, see the DIGIOP website at www.digiop.com/support. Click on Servers from the drop-
down list to locate the minimum requirements for each software version. 
 

Starting the system software 
 
WARNING: Make sure the power sources are reliable earth grounded. This helps prevent 
personal injury or damage to the equipment. 

1. Before connecting the power, ensure that the power switch (AC110V ~ 120V ->115, 
AC220V~240V->230V) is switched to 110VAC. 

 
2. Make sure all cables are firmly attached. 
 
3. Ensure all cameras are powered on and operating properly. 
 

4. When all connections are correct and secure, turn on the main power to the DIGIOP 
system.  
 
You should see the Windows XPE software load, and then the DIGIOP software. 
This should only take a few moments.  
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The DIGIOP multi-image screen appears and displays the connected cameras. (This is for 
example purposes only. Your display may vary, depending on the DIGIOP model you 
purchased.) 

. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Logging In 
 
1. Click LOG IN (bottom right of screen). 
 
NOTE: After you successfully log in, the TOOLS button  
replaces the LOG IN button. 

 
2. Using either an external keyboard or the small, on-screen 

keyboard, enter a username and password.  
 
NOTE: The default Administrator username is admin. Default Password is 
dg2ad33 
 

NOTE: The on-screen keyboard is found beside many fields and can be 
used for data entry. As you click on the alphanumeric symbols, the data 
appears in the small text field below the keys. Click the Input key (not the 
Enter key) to confirm what you type. Click the X to close this keyboard.  
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Logging Out 
 
3. From the Tools menu, click Log Out. 
 
 
The application shuts down and the LOG IN button replaces the 
TOOLS button. 
  
4. Click LOG IN and enter a username and password. 
 
 
 
 
 

User Accounts 
 
DIGIOP systems contain a default administrator (or “admin”) account to let you access 
the system once it is powered on. The admin account cannot be deleted or renamed, 
making it is always available for system access. You can, however, change the admin 
password and we recommend that you do this for security purposes. If you change the 
password, write it down and keep it in a safe place for reference, as needed. 
 
When you log in the first time, enter the following information in the Login dialogue: 
  

• Username — admin 
• Password — dg2ad33 

 
IMPORTANT: If you forget your password or it is not working, see Appendix K in this guide, which 
provides steps for resetting a lost password. 
 
Table 2 contains a list of user accounts and the default permissions assigned to each: 

 

Table 2. 
User Accounts 

Name 
 

Password 
(Case sensitive) 

Description 

admin  dg2ad33 Access to all functions 

Manager  Access to all functions except System Users accounts, 
including adding Remote Users; restricted search 
functions: access only to Hour Backup, but no access to 
Configure, Smart Search, Sensor Events, or Still 
Image/Minute Backup 

Installer dg2in23 Access to all functions except search and POS 

Security User dg2seclv1 Access only to PTZ, Search, and POS 
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Exiting and Shutting Down 
Exiting DIGIOP system application 
To exit the application (without shutting down the system), click TOOLS > 
Exit DIGIOP. This stops the system completely and no recording or system 
updates will occur. This does not completely shut down the system, however. 
 
The Server software stops and the DIGIOP desktop background appears. 
CAUTION: A number of system-related applications are still running. Tampering 
with these can cause severe damage or irreversibly affect the system. Do NOT 
tamper with these settings unless directed to do so by DIGIOP Technical Support. 
 
After you shut down the software, you can continue to access many 
Microsoft Windows programs, features, and functions, including network 
connections, printer setup, search, DOS prompts, and any external storage 
devices, such as USB memory, CDs, etc. 

 

Shutting down the system 
This operation completely shuts down the system. 
 

NOTE: Shutting down the system through the Shut Down option can only be 
performed by someone with administrator privileges. However, the system can 
still be shut down with the power button. 
  
1. Click the LOG IN button. 
 
2. Enter the username and password (default username = admin; 

password=dg2ad33) 
 
3. Click the TOOLS button 
   
4. From the menu select Shut Down – the system will shut down. 
 
IMPORTANT: The menu option Log Out simply logs out the current user. A new 
user needs to log in to access the system. Exit DIGIOP stops the system 
functions and returns to the WINDOWS XPE. Shut Down turns the system 
completely off. If you select Shut Down, be sure to back up the system first. If you 
do not, any changes you have made will be lost when you restart. 
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Abnormal shut downs and restarts 
 
The DIGIOP software contains a number of safety systems that ensure the system 
integrity under abnormal operating conditions.  
 
• Operating System (OS) failure (lock up) — The DIGIOP internal watchdog circuit 

monitors the operation of the Windows XPE operating system. If the system fails for 
any reason, the internal watchdog restarts the system. This takes about 10-15 minutes 
to restart. 

• Pressing the Power button on the front of the system — The DIGIOP system shuts 
down and then closes Windows XPE correctly. When the system boots back up, it 
will attempt to recover from the last backup point.  

• Disconnecting main power (assuming no UPS) — Once the main power is restored, 
the system restores the OS from the internal backup and then restarts the system.  

 

Auto log off 
 
If you leave the system running for more than 10 minutes, 
it automatically logs you out. A Warning Message similar 
to the one shown here appears for a short time. This is a 
notification that an automatic log-off is about to occur.  
 
NOTE: This message disappears automatically. You do not 
have to click OK to start the log off. 
 
 

Pausing Recording 
 
You must always pause the recording to change recording type 
parameters, e.g., FPS, resolution, schedule, etc.  
 
Click Pause Recording stops the recording of all camera video to the hard 
drive. If no actions have been performed on the system, it resumes 
recording after 15 minutes. 
 
IMPORTANT: If for any reason an option is unexpectedly disabled (i.e., “greyed 
out”), pause recording and try it again. 
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Restarting DIGIOP from the TOOLS menu 
 
You can restart the DIGIOP system directly from the TOOLS menu while 
the application is running by clicking Restart DIGIOP. 
 
You might want to restart in this way to refresh the system, such as when 
adding cameras. For related information, see the section “Adding IP and 
Analog cameras” in this guide.   
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DIGIOP Main screen 
The main DIGIOP screen contains many configuration tools, menus, and other on-screen 
information, which are described in this section. This example shows one variation of the 
possible layouts, showing 32 “channels,” or panes. In these channels, you can 
simultaneously view live and archived camera video and perform other functions. 
 

 

Table 3. 
Main Screen 

Item Name Description 

 

Site Name User-defined description of this system. To configure, double-click the screen area and a 
text entry option appears. Or, go to TOOLS >Configure>System. 

 

IP Address If the system is connected to a LAN, a static IP Address can be defined. To set the IP 
address, go to TOOLS>Configure> Network. Contact your system administrator about setting 
up this address. 

 

Clock Displays the current time and date of the DIGIOP system. This can be edited by double-
clicking this area. 

1 

2 

3 

10 

6 

4 

5 

3 

9 8 

1 

 

2 
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Table 3. 
Main Screen 

Item Name Description 

Round 
control dial 

cluster 

Controls from which you can select the multi-screen (split-screen) mode 
and the sequence in which images are displayed  
 
The numbered buttons represent the number of images displayed on 
screen (4-32).  

Split-Screen 
Selection 

The number currently highlighted in yellow is the current selection for the split screen (e.g., 
4 images). By clicking this highlighted button, the next set of images is displayed. For 
example, if you are watching images 1-4, and click the “4” button, the next sequence of 4 
images is displayed.  
NOTE: To configure the split screen sequences, go to TOOLS>Configure> Display >Display 
Division. For more information, see the section “Tools” in this guide. 

Sequence 
Images 

Causes the images to automatically rotate or cycle through the images in a defined order. 
Stopped by clicking the same button again or by selecting a camera.   
NOTE: To change the dwell time (amount of time each image is displayed), go to 
TOOLS>Configure> Display. Settings are 1-60 seconds. For more information, see the 
section “Tools” in this guide. 

 

Full Screen 
Mode 

Hides the controls so the image fills the entire screen. Click or right-click and the controls 
are re-displayed. 

 

Camera When camera video is recording, the associated camera button is highlighted. 
In “motion” record mode, this button appears normal (not highlighted). 

Sensor Each time a sensor is activated, the associated button is highlighted (indicator 
only). 

 

 
Camera, 

Sensor, and 
Control 

Control Interactive buttons connected to the available relay outputs. If a sensor triggers 
an output relay, the associated button is highlighted. You can override the relay 
status by clicking the appropriate button. 

 

Events Blinks red to indicate that events are being recorded 

 

Remote Turns red to indicate someone is connected remotely. Can click to see who is connected. 

 

Tools See the section “Tools” in this guide. 

6 

7 

8 

4 

5 
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Table 3. 
Main Screen 

Item Name Description 

 

DIGIOP logo Double-click the logo to view the Version Information, including 
Model, Version, and System Information, as well as Record 
Amount Information. 

On-image 
Information 

Displays the current status of the camera 
recording mode, the sensor input, and the 
control relay outputs. 

Camera Name Indicates the name of the camera, which is set up from TOOLS > Configure > Camera. 

Audio 
recorded  

<A> 

Indicates audio is recorded with this video.  

Record Mode 
M 

Indicates the mode for camera recording, e.g., motion M, continuous record C, sensor 
record S, no record F, etc. Set up from either TOOLS > Configure > Camera or Tools > 
Configure > Schedule.  

 

PTZ available Opens the PTZ control panel. PTZ is defined from TOOLS > Configure > PTZ. 

 

Viewing version information 
 
Click the DIGIOP logo to view the 
system Version Info.  
 
This includes: 
 

• Model  
• Version  
• System  
• Record Amount  

 

9 

10 
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Setting the Clock 
System clocks can be manually set or set by a “time server” application. The DIGIOPT 
software uses a time server that synchronizes all the DIGIOP clocks on a network to a 
single time.  
 

1. If the system is not on a network, simply double-click the clock on the 
screen.  

 
NOTE: For how to set the clock if the system is on a network, use the Network tab. For 
information about this setting, see the section “Time Synchronization settings” in this guide. 
 

The Date / Time Setting window 
appears. 
 
 
 
The default is USER EDIT, which 
lets you manually change the 
Daylight saving time options. 
 
 
 
 
 
 
 
 
 
 
 
 

2. Choose a region from the drop down 
menu by Select Nation. 

 
3. Set the time manually. 

 
IMPORTANT: After you set the time, recording 
pauses briefly while the system resets. 

 
 
4. Or, automatically set Daylight savings time 

by checking “Automatically adjust for 
daylight savings changes.” 
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Switching between multi-image screen and single-image screen 
 

1. From a multi-image screen, 
double-click the image you want 
to view as a full screen.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The image expands 
to fill the entire 
screen. 

 
 
 
 
2. Double-click again 

to return to the 
multi-image. 

 
 
 
 

Double-click 
for full-screen

Double-click for 
multi-screen 
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TOOLS menu 
 
The TOOLS menu runs the dialogues and menus to configure DIGIOP Server software. 
Table 4 describes the Tools options. The Search option is discussed in detail in the next 
section. For information about the other options, see the DIGIOP G3 Service Guide. 
 

Table 4. 
Tools menu 

Icon Name Description 

 Pause 
Recording 

Pauses all camera recording. In most 
cases, you must pause the recording to 
change recording parameters, e.g., FPS, 
resolution, schedule, etc. 

 
Search Opens the Search application. Also 

includes video backup (video clips, entire 
records) and still image save/print. 

 
Configure Opens the main system configuration and 

settings menu. 

 
Remote Login Opens a real-time log of logins to the 

system from Remote devices (can include 
Remote Manager and integrated 
software). 

 
Event Log View Opens a real-time log of the operational 

and alarm events generated by the 
system. 

 
POS (Point of 
Sale) 

A separately licensed software package 
that records transactions (e.g., cash 
register) with video clips; not activated 
until licensed. Also called DTM (DIGIOP 
Transaction Manager). 

 
DIGIOP ESP (Provided on all systems) Web-based IP 

configuration, management, and viewing 
application. See the ESP User Guide on 
the CD with your system. 

 
Log Out Logs out the current user. The system 

automatically logs out after 5 minutes of 
inactivity. 

 
Restart DIGIOP Closes and reinitializes the DIGIOP 

system software. 

 
Exit DIGIOP Shuts down the DIGIOP system software 

and exits to Windows XPE environment. 

 
Shut Down Completely turns off the DIGIOP system, 

both software and hardware. 
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Search Menu 
IMPORTANT: The DIGIOP G3 User Guide only describes the Search menu option. 
For information about all the menu options, see the DIGIOP G3 Service Guide. 
 
The Search menu lets you view, analyze (reprocess), manipulate, and export 
in different modes/formats. You can access it from Tools > Search. 
 
IMPORTANT: By default, the Search mode takes you to the end of the current 
recorded files. No new recording occurs while the Search is running. 
 

 
 

3

1

7

8
6

2

5
4

9 
10 

11 
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Table 5. 

Search Preferences 
 Name Description 

 

Current Date & Time Displays the PC date and time  

 

Record calendar Use the calendar to find recorded video on 
the desired search date. Use Prev(ious) or 
Next links to move the months forward or 
backward in time. Use the Up/Down arrows 
to adjust the Year and Month. 
Date codes: 
Pink — recordings available on that date 
Yellow — currently selected date 
Grey — no recordings on that date 
 

 

Time Line (Hour/Min) Displays the current system time. Clicking 
anywhere on the time line causes the Scan 
Bar to jump to that position/time. Use the Hour 
and Minute up/down arrows to locate known 
records. This option is synchronized with the 
Scan Bar so any change to the Scan Bar position will be reflected here. 

 

Playback Controls Play, Stop, Pause, FWD, Step 
Forward, Step Backwards. See the 
section “Playback Controls” in this 
guide for more information about these controls. 

 

Screen division display Switches from 1, 4, 9, or 16 images. Individual images can be 
removed from the split screen by clicking the camera button 
(left of the graphical record log). The selected Screen Mode is 
highlighted. 

 

Tools (Search) Provides access to tools for doing searches, which include Image Processing, 
Smart Search, Hour Search, Search, Configuration, POS, and Image. For 
information about each of these tools, see the section “Search Tools” in this 
guide. 

 

Playback speed Lets you choose forward or playback at speeds of ⅛X, ¼X, 
½X, 1X, 2X, 4X, and 8X real-time speed. To adjust the 
playback speed, either drag the slide control or click on the 
slide control bar. The speed is displayed in the playback 
window. 

 

Print, Zoom, De-
interlace, Image/Video 
BackupControls 

Print — Prints the image 

1 

2 

3 

4 

5 

6 

7 

8 
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Table 5. 
Search Preferences 

 Name Description 
Image Zoom — Magnifies the image in 48 incremental steps. 
Right-click with the mouse. When you place the mouse over the 
image, the cursor changes to the +/- magnifying glass. Clicking 
the left mouse button zooms out to 1:1 ratio. By moving the mouse 
to different areas of the image, you can zoom in on parts on the 
image that you need to look at in more detail. This means that the zoom does not 
need to be centralized in the middle of the screen to work. See the section 
“Zoom” in this guide to see a zoomed image. 
Image/Video Backup — Lets you access several options for 
copying images (other then HOUR BACKUP), including: Video 
Backup (DSF format and viewer); Still Image Backup; Standard 
format (MPEG format) 

Interlace/Deinterlace (4CIF) — (Only applies to the S-Class 
systems when processing 4CIF recorded data) When printing 
the interlaced fields 4CIF images where the source was a 
dynamic (moving) image, the DVR captures “Even” and 
“Odd” fields to create the frame. Greater clarity may be 
gained by viewing the images separately. Option normally 
used while processing images for printout. See the section “Viewing 
Interlaced/Deinterlaced images” in this guide for information about this option. 

 

Graphical record log Displays a 24-hour time period for the time and date selected. Double click to 
zoom in on the time line. The time zooms in from 24 hours to single hours. By 
double-clicking the time line, the time line zooms in for searches in smaller time 
increments.  
Different colors represent different recording modes: pink=continuous; 
blue=motion; red=sensor.  
 
See the section “Manipulating the Graphical Record Log” in this guide for more 
information about how to use the timeline features. 

 

Cameras selector and 
scroll bar 

Displays camera images in multi-screen divisions of 1, 4, 9, and 16 
cameras. Cameras not selected are not visible. For single images, 
use the camera selection buttons to move the displayed image 
from one camera to the next. For multi-screen divisions, use the 
camera selection buttons to select or de-selecteach camera from 
the search/display. The scroll bar can be used to access the other 
cameras not shown. 

 

Scan bar (cursor) Lets you slide a scan bar along the time line and quickly select and 
view video. A preview pane displays the images as soon as the files 
are accessed. By double-clicking the time line, the time line zooms in 
for searches in smaller time increments. 

 

 
 

9 

10 

11 
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Searching for recorded video 
 
The Graphical Record Log is used to search for the video record you need. The following 
procedure describes the steps to take to do a search. 
 
1. Open the Search 

Dialogue. 
 
2. Select a camera whose 

video you want to search. 
The selected camera is 
outlined in yellow in the 
viewer. 

 
3. Look at the calendar [1] 

to see when recorded 
video for the camera is 
available. Dates in pink 
indicate video was 
recorded on that day. 

 
 
 
 
4. Select an approximate date from the calendar of the video event you want to see. The 

video begins to run in the viewing window. 
 
5. The timeline is first displayed in 24-hour intervals. Click somewhere on the timeline 

to select an hour [2].  
 

 
You can also select the date from the calendar [1, above] and change the 
hour or minute with the up and down arrows on the Hour/Min clock [3]. 

 

2

3 

1 

Search Menu, continued 
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6. Use the video controls [4] to control the video play. Be prepared to stop and rewind 

the video, fast forward, etc. to locate the segment you want. 
 

 
 
 
Move to end of available files 
Frame by frame step forward 
Play forward at selected speed 
Pause/Stop 
Reverse play at selected speed 
Reverse frame by frame 
Move to beginning of day files  

 
Speed up or slow down the Playback Speed of the video [5] using the slide 
control. The maximum playback speed is 8x. 

 
7. Double-click once on the dark bar at the top of the time line to zoom in to a 

shorter time interval. The time zooms in (expands) from 24 hours to approximately 
six hours, with the selected time roughly in the center of the time line.  

 
8. Slide the vertical Scan bar along the time line to another time. You can also move the 

slide control below the time line [6] to the right or left to change the time.  

 
9.  Double-click a second time to zoom to a shorter time interval. The time line now 

shows slightly more than three hours. (The next time you Double-click, the time line 
returns to the 24-hour time period. 

 
 

4 

5

6
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10. When you locate the section of video you want, you can zoom in to see more details. 
Here is an example of how the video can look at maximum zoom. Zoom magnifies 
the image in 48 incremental steps  

 
You may now want to copy the video or snapshots from the video. See the next sections 
“Copying video,” “Copying still images,” and “Copying Standard images” in this guide. 

Copying Video 
 
1. From the Search window, click Video Backup. 
 

The Copy Video to CD window appears. 

 

2. Click the Copy Video tab. 
3. Place a checkmark beside the camera(s) whose video 

you are copying.  
4. Select the Start Date/Time and the End Date/Time. 

Use the drop arrows to open the calendar. 
5. Click the Add button to add this selection to the List 

of video segment times to copy.  
6. Repeat Steps 2 and 3 for other selections. Each time, 

click Add.  
7. Browse to the Destination for the copied file. Backup 

must be to a CD/DVD, removable drive, or network 
device. The system will scan the selected drive and 
display the available free space. From the Backup Period List, select one or more 
periods to back up on the media you have available. The file size of the selected 
cameras and dates/times will be displayed under the Space information. 

8. (Optional) If the CD requires formatting, click the Format CD RW/DVD RW option. 
9. Click Start Copying. The file is in encrypted .DSF format. 

No zoom Maximum zoom 
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Copying Still Images (.BMP or .JPEG) 
 
This option saves still images. 
 
1. From the Search window, click Video Backup. 
 
2. Select the Copy Still Image tab. 
 
3. Pause the playback. 
 
4. Place a checkmark beside the camera(s) whose still 

image you are copying.  
 
5. Select the format in which you want the image 

(.BMP or .JPEG). 
 
6. Browse to the Destination for the copied file. 

Backup must be to a CD/DVD, removable drive, or 
network device. 

 
7. From the number of frames selector, select how 

many frames to save (1-100) using the up and 
down arrows. 

 
8. If the CD requires formatting, click the Format CD option. 
 
9. Click Start Copying. The image is copied in the selected format to the media. 
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Copying Standard Video – MPEG Format 
 
This option saves standard, MPEG video. 
 
1. From the Search window, click Video Backup. 
 
2. Select the Copy Video(MPEG Format) tab. 
 
3. Pause the image at the approximate point 

where the video sequences should start. 
 
4. Place a checkmark beside the camera(s) 

whose video you are copying. 
 
5. Browse to the Destination for the copied file. 

Backup must be to a CD/DVD, removable 
drive, or network device.  

 
6. Using the Up/Down arrows, select the 

Duration: Start Time and End Time.  
 
7. If the CD requires formatting, click the 

Format CD RW/DVD RW option. 
 
8. Click Start Copying. The video is copied in MPEG format to the selected media. 
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Viewing Interlaced/Deinterlaced images 
As an enhancement feature, you can run the Interlace/Deinterlace option. 
 
NOTE: The Interlace/Deinterlace option is only applicable on the S-Class systems when 
processing 4CIF recorded data. It is normally used when processing images for printing.  
 
1. Click Deinterlace on the Search window to display the 

interlaced frames.  
 
 
 
 
 
 

The default image is the interlaced image. The Deinterlace 
option lets you view the EVEN and ODD fields of a frame.  

 
 

 
 
2. Click the Deinterlace button once to access the Even fields. 
 
 
 
 
 
3. Click it again to access the Odd fields. 
 
 
 
4. Click it again to return to the default Interlaced image. The 

selected field can be viewed during playback or while an 
image is still. 

 
 

Interlaced 
frame 

Interlaced 
fast moving 
image (zoom) 

Odd field of 
the same fast 
moving image 
(zoom) 

NOTE: 4CIF images are interlaced. When 
printing an image where the source was a 
dynamic (moving) image, the system 
captures “Even” and “Odd” fields to create 
the frame. Greater clarity can sometimes be 
gained by viewing these fields separately. 
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Search >Tools Menu 
The Search option provides its own individual set of Tools for 
enhancing images (Image Post Processing), doing Sensor Event 
searches, and other functions.  
 
1. To access this set of tools, from the Search window, click the 

Tools button. This opens the menu shown here. 
 
2. Select a tool. 
 
These Search Tools are described in the following sections. 
 
 
 

 

Enhancing images with the Image Post Processing Tool 
 
After a search is completed, you can enhance single images through the Image 
Post Processing feature of the Search Tools menu.  
 
1. From the Search window, select a date from the calendar and begin a video 

search for an image you want to enhance (i.e., “post process”). 
2. Click on the Search timeline to display recorded video for the date. 
3. When you locate an image you want to enhance, click the Tools menu. The 

Search > Tools menu appears. 
4. Click Image Post Processing. 
 

The APP window appears. It 
contains the archived video from 
the selected camera. 
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Under the Preview panels, the video you selected appears as a series of images. Selecting 
the exact time is not critical at this point since the Image Post Processor can display all 
the images in the video. 

 
• The Preview panels display a series of images for 1 hour of video (if a full 

hour exists). If the camera was set for Motion, there may be less than 1 hour. 
• The Preview slide controls shows the time the camera started recording. It is 

formatted as HH:MM:SS:1/1000 ref. Moving the slide control scans through 
the full hour of images in increments defined by the 1/1000th reference. 

• Each thumbnail preview is captioned with the time and 1/1000 frame 
reference number. 

 
5. Use the enhancement options (Processing Modules) to change the color, contrast, 

edge sharpness, etc. of the image. These options are typical of most video editors and 
work using stepped enhancements:  

 
6. Change the image with these options until you have the desired effect.  
 
NOTE: To reset or restore the original image (make the Post Process image to match the 
Channel Input image), click Reset. 

Using Image Post Processing produces two images: 
 
• Channel Input — Original file image pulled from the HDD 
• Post Processed —  Channel Input with the real-time enhancement changes 
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7. (Optional) To edit the image using fine or course settings, from the APP window, 

click Edit > Filter Option. 
 
 
 
 
 
 
 
The Option window appears.  
 
8. Move the slide controls to 

adjust the image. Try various 
settings until you achieve the 
desired affect. 

9. Click Default to reset to the 
original settings. 

 
10. Click OK to finish. 
 
 
 
 
 
 
 
11. To save or print images 

after post-processing, click 
File. Images can be saved in 
either BMP or JPG format. 

 
 
 
 
 
 
 
 
 
12. To copy an image to the clipboard, click Edit menu or 

the Copy icon. 
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Using the Smart Search tool 
 
Smart Search (also called “Museum Search”) lets you analyze video for movement after 
it has been recorded. Beginning with a video recording, you draw motion-sensitive areas 
directly onto the image. Any activity occurring within these areas creates an event that 
the software then logs to the Smart Search list.  
 
For example, you might want to know the specific time(s) that cars entered and exited a 
parking lot, but you had not set up motion sensitive areas to detect these as they occurred. 
With Smart Search, you can return to the video and perform a post-video analysis of it. 
By setting up specific areas in the Smart Search on the recorded image to look for cars, 
you can look for the information you need. 
 

Running a Smart Search 
 
1. From the main DIGIOP window, select TOOLS > Search. 
 
 
 
 
 
 
 
 
 
The main Search window opens. 
 
2. Click on a camera image you want to analyze. The 

border of the selected camera is highlighted. 
3. Select the date/time to start the search of the video 

recorded on this camera. 
 
 
 
 
 
4. From the Search window, click Tools. The Search 

Tools menu opens. 
 
5. Click Smart Search from this menu. 
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6. The Smart Search window appears. 

This contains the camera video image 
plus the camera name (Channel 
Information) and the date and time of 
the search.  

 
NOTE: Initially, the data area on the right is 
empty until you run a search. In this example, 
the Smart Search was already run so some 
information is already shown.  
 
 
 
 
 
 
 
7. In the Search field, enter one of these options: 

• Type the Start Time and 
End Time you want to 
the search to begin and 
end or use the up and 
down arrows to select the 
time. 

• Or, check the File Begin and File End checkboxes to match the start and end 
times to the available file content. 

 
NOTE: By default the system opens with the Start Time set to the beginning of the first recording  
for that camera on the selected day (initially, this is the same as the “File Begin” time). The End 
Time is the time the file ends (initially, this is the same as “File End” time). 
 

 
8. Click Go to Start to see where the video begins. 
 
9. Adjust the Start Time and End Time as necessary to locate the desired video. 
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10. Place a checkmark in a 

Search Area Section to place 
a Block or a Square to define 
the search regions: 
• Block — Click on the 

desired location on the image to add a fixed-size 
square. You can add up to 20 horizontal and 15 
vertical blocks to the image. 

• Square —Click on the desired location on the image 
and then drag the mouse to define a “square” region.  

 
NOTE: Multiple blocks and squares can be added to a single 
image to create the motion sensitive regions you want. Blocks and 
squares can overlap. 
 
 
11. Check Move to move blocks and squares to new locations. You can also Delete them. 
 
 
12. Place a checkmark in View Search Process to view all 

video, not just the images where movement is detected.  
 
NOTE: When this option is unchecked, the only images that are 
previewed are those where movement is detected. In this case, if 
no event is found, the image does not change. 
 
 
 
13. Adjust the Sensitiveness slide control for the percent of 

movement required to trigger an event. The number of 
events appearing on the event log reflects the sensitivity of the regions, i.e., 100% 
sensitivity generates more events. 
• 0% — Not sensitive to movement 
• 100%— Very sensitive to any changes in the defined regions. 

 
 
14. If you would like to speed up the search process, check the Quick 

Search option. Searches may be done up to 20% faster using this 
option. 

 
NOTE: During DIGIOP testing, a 10-minute recording was completed approximately 20% faster 
with Quick Search. Search times typically take 60 seconds for 10 minutes of video. The Quick 
Search only reviews the “index” images and ignores the other images. In a relatively motionless 
scene, this option could save considerable search time. If the Quick Search option not selected, 
the search feature reviews every image recorded. 

Block 

Square 
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15. Begin the search by clicking Search Next 

Movement. The search pauses at the first event 
(i.e., movement is detected inside a defined 
sensitive region). Each event detected in this 
way appears in the list with a start and stop 
time.  

 
16. Click Search Next Movement again to move to 

the next search. 
 
 
17. Continue to click Search Next Movement until 

the search is complete. You can also select Search All, which erases the current 
search event list and re-starts the search. It can be stopped, but not paused. It will 
automatically search instead of 

 
 
18. Play the events in the list by highlighting an event and clicking the Playback control. 

Other Search Controls are described in Table 6: 
 
 

Table 6. Search Result 

 Go to start of file  Pause playback  Playback  Fast Forward  Go to end of file 
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Table 7 describes additional Smart Search options.  
 

Table 7. 
Other Smart Search Options 

 Name Description 

 

Zoom 
 

Only impacts playback. (1) Choose a record. (2) Click Zoom. (3) Use the 
mouse scroll wheel to enlarge an area (e.g., a square or block). (4) Press Play 
and the video plays back at that zoom magnification. At the end of the 
playback or when a different video record is selected from the Smart Search 
list, the zoom magnification is retained until the Zoom is clicked again and the mouse 
wheel is used. To disable Zoom, click the Go to start playback control (defined in  
Table 16).  
 

 

Speed slide 
control 

Only impacts playback. The playback speed varies depending 
on the frame rate at which the recording was made. At the 
lowest setting, the video plays back at about 1 fps.  
 

 

Search Next 
Movement 

Searches the video from 
the selected camera for 
motion events 
 

 

Search All Erases the current search event list and starts the search from the beginning again. The 
search can be stopped but not paused. Events are listed by start/end times. 

 

Stop Search Terminates the search completely (no pause option is available) 

 

Print Prints the first image of the search event 

 

Erase List The Erase List button erases the list and is the same as pressing 
Search All. 

 

Save Launches a folder browser where you can select the 
destination folder. A folder and file are created as 
either a .BMP or .JPG.  
The folder/file format is:  
Folder and file —  20060118-071746.079-01 
The name format is: 
YYYYMMDD – HHMMSS.RRR – Cam# 
(where RRR is a 1/1000 second reference number) 

 
 
 
 
 
 

1 

2 

4 

5 

6 

7 

3 

8 
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Saving .DSF files each hour with the Hour Backup Tool 
 
This option saves .DSF files to backup storage media in 1-hour 
increments.  
 
NOTE: The .DSF files are not decrypted. 
 
1. Click Search > Tools > Hour Backup. 
 
 
 
 
 
 
 
 

The Backup window opens. 
 
 

2. Click the Select Backup Date drop-down and highlight 
a date to back up. 

 
3. Select a camera from the Camera Number list. Press 

and hold the Ctrl key to select multiple cameras. 
 
4. Select an hour/file(s) from the Hour list or press and 

hold the Ctrl key to select multiple hours/files). 
 
NOTE: The total estimated storage requirement for the selected 
files is listed under Selected file size. 
 
 
 
 
5. Select the Backup Path to save the file to by 

clicking the Open Folder Browser icon.  
 
6. (Optional) If saving to a CD/DVD, use the 

Format DVD RAM or Format CD buttons. 
 
NOTE: The available storage capacity of the selected path is listed under Target free space. 
 
7. Click Save to save the files and a .DSF viewer to the specified directory. 
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Searching for lists of camera with Sensor Events Tool 
 
The Search Sensor Events search tool produces a list of all sensor 
events for the selected camera. You can then print snapshots of these 
events to use as needed. 
 
1. From Search Tools menu, select Search Sensor Events.  
 
NOTE: If you are viewing a multi-division screen when you search for these 
events, all the camera views are synchronized (or updated to closely match) 
the date/time of the camera you are searching. The Graphical Time Line is 
also updated. 
  
 
 
 
 
 
2. Select a camera to search from the Camera Number list. You 

can also search all cameras at once by clicking Select All. 
 
3. Click OK. 
 
 
NOTE: A disabled checkbox indicates that that camera has no recorded 
images for that date/time. 
 
 

The Sensor Event List for the selected camera (under 
Camera Num) appears. Events are shown by Time, Event 
Type, and Sensor number. 

 
 
4. Highlight an event by selecting a time corresponding to 

the event occurrence. To review the Previous or Next 
Date, click the appropriate button. You are prompted if 
there is no Previous / Next Date. 

 
5. Click Locate. 

 

 
6. Select the camera(s) for which images are to be printed. 
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Adding printer, adjusting volume, searching with Configure tool 
 
The Search Tools > Configure option provides three features: 
 

• Add Printer 
• Search Option 
• Volume Control 

 
 
 
 
 
 
 

Add Printer 
Use this option to add Windows compatible printers. Ensure the 
number of installed printers is kept to a minimum as there is 
limited HDD space (disk space) available on the drive.  
 
1. Click the Add Printer button to browse for the  

printer files. 
2. Once the Printer is added, go to the TOOLS>Configure> 

System tab and Backup the system. 
 
 

Search Option 
This option searches a CD or DVD for .DSF video 
files and displays them on the timeline. 

 
 
 
 
 

Volume Control 
This control lets you adjust the playback audio volume using a 
sliding volume control. 
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Using the Image Adjust Tool during live playback 
 
This Search Tools option adjusts the live playback of a video 
record. When you are done, the image reverts back to the default 
settings. This option does not let you save the settings. 
 
 
 
 
 
 
 
 
 
 
 
 
1. Click Image Adjust. The window shown here with Camera Num 

appears. 
 
2. Select the camera to adjust from the Camera Num drop-down list.  
 
NOTE: This option lets you adjust settings to one camera at a time. 
 
3. Select any one or more Image Filter options. The image will be 

adjusted according to the filters chosen. 
 
4. Adjust the Brightness as required (real time preview update). 
 
5. Adjust the Contrast as required (real time preview update). 
 
6. Press Play to view the video record. 
 
7. To restore (normalize) the image again, click Initialize to revert all 

settings back to their default values. 
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Other TOOLS options 
Other options are found on the main TOOLS menu. These are described in this section. 

Remote Login option 
Opens a real-time log of logins to the system from remote devices (can include Remote 
Manager and integrated software). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Event Log View Option 
Opens a real-time log of the operation and alarm events generated by the 
system. 
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POS (Point of sale) Tool 
This is also known as the DTM (Data Transaction Manager) and requires 
another license as it is not included in system pricing. Please contact your 
DIGIOP Dealer for more information. 
 
NOTE: For more information, see the DIGIOP Data Transaction Manager User 
Guide on the website at www.digiop.org/support. 
 



   

48                                                                                                                                DIGIOP G3 User Guide 

Appendix A. 
DIGIOP System Tray programs  
 
Several programs found in the Windows System Tray at the bottom of the DIGIOP Main 
window. The DIGIOP Server System Tray and its components are identified below: 
 
NOTE: The tray icons may appear in a different order than this example. 

 

 

Shutting down the NetBackup Agent 
 
Occasionally, you may need to exit the DIGIOP Server application to view settings or to 
check system files. If you need to exit the DIGIOP Server application, you must first 
close the NetBackup Agent, the operation of which prevents access to many applications 
needed for troubleshooting, including Microsoft Windows Explorer, Search, etc.  
 
IMPORTANT: When you exit the DIGIOP Server application for more than 5 minutes without 
closing the NetBackup Agent, the system reboots and goes into a recovery mode. If this should 
occur, you need to restart the DIGIOP Server application and restart this process to prevent the 
system reboot. 

Time Server 
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To shut down the NetBackup Agent 

 
1. Backup the system to save any configuration or other changes. The Backup feature is 

accessed from TOOLS>Configure>System. 
2. Right click on the icon NetBackup Agent  in the System Tray. 
3. From the pop-up menu, select EXIT[X]. 
 
You can now access Microsoft Windows Explorer. 
 

Disconnecting USB devices 
 
1. To correctly disconnect any USB device, run 

the “Safely Remove Hardware” application.  
 
2. Double-click the tray icon and follow the 

Windows instructions to remove the device. 
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Appendix B. 
DIGIOP hard drive configuration 
DIGIOP systems perform specific hard drive partitioning, which you can observe from 
Microsoft Windows Explorer. To access Explorer, you must first shut down NetBackup 
Agent. See Appendix A for information about shutting it down.  
 
IMPORTANT: Be sure to back up your system before shutting down. The Backup feature is 
accessed from TOOLS>Configure>System. 
 
• DIGIOP systems are all configured using multiple partitions.  
• Partitions may contain the operating system, drivers, and setup or data files. 
• Most of the DIGIOP files and software are in folders called DIGIOP or DissTech. 
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Table B 
DIGIOP Drive Partitions 

Drive Size Description 

CAUTION: Do not access or modify any drives unless specifically directed to by DIGIOP 
Technical Support.  Most of these files are encrypted and affect system operation. 

DIGIOP C:\ Drive Approx. 1.91GB Windows OS and the system software; Windows 
folder structure 

DissTech D:\ Drive 16.85GB DSF video/audio data files and log files 

DTA E:\ Drive  Approx. 1.95GB POS (Point of Sale or DIGIOP Transaction Manager) 
software 

SYS F:\ Drive  Less than 1GB • DIGIOP system files, including system drivers 
• System license file (in Settings folder)  
• User settings(in Settings folder)  

DissTech G:\ Drive  Varies in size 
depending on system 
configuration 

• DSF video/audio data files  
• Log files 

Unlabelled Drive  Hidden system drive that contains the image backup 
for the C:\ Drive system restore. If the system stop 
communications or if Windows or the system fails 
unexpectedly, the data on this drive overwrites the 
data on the C:\ Drive. In this way, system 
configuration and license data is not lost. 

IMPORTANT: To ensure that system configuration and license data is not lost, you must back up the 
system regularly or whenever the system is reconfigured. The Backup feature is accessed from 
TOOLS>Configure>System. 
 

Other Drives 
Depending on the configuration of the system and the amount of storage space available, 
other drives may be used for data storage. Once the system has consumed all DissTech 
storage drives, it searches for the next drive in alphabetical order and starts recording data 
on that drive.  
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Appendix C. 
System Recovery DVD/CDs 
 
The System Recovery DVDs/CDs contain three options, which perform the following 
functions: 
 
• Option 1 — DIGIOP software rewrites the Operating System (OS) by reformatting 

and partitioning the hard disk drives (HDDs) 
• Option 2 — DIGIOP software deletes the existing data from the HDD  
• (not available on some systems) Option 3 — Contains hardware diagnostics, BIOS 

and CMOS updates, and HDD flash utilities 
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Appendix D. 
Activating the system 
 
To activate your DIGIOP system, perform these steps: 
 
1. Choose Activate DIGIOP 7 Online.  

 
Or, if an Internet Connection is not available, 
choose Activate By Phone. 

 
NOTE:  Contact DIGIOP Technical Support when 
activating by phone. 
 
 
 
 
 
 
 
 
 
2. Enter your License ID and Password (located 

on the sticker on your system).  
 
 
 
 
 
 
 
 
 
 
 
3. Click Continue. 
4. By Phone: If you are activating the license by phone, the system will provide you 

with User Code 1 and 2. With the User Codes, you then must contact DIGIOP 
Technical Support to obtain Activation Codes.  
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5. Enter the User Codes and Activation Codes in the fields provided. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Click Continue. 
 
7. Once the license has been successfully activated, click Continue.  
 
NOTE: The license code is based on a number of factors, e.g., MAC address, system 
configuration, and Serial Number. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Click OK to complete the License setup. 
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Appendix E. 
DIGIOP Current and Factory settings 
Current software and image versions, DVR serial number, update dates, etc. can be found 
through Microsoft Windows Help and Support in the CURRENT SETTINGS and 
FACTORY SETTINGS window. 
  
1. Click TOOLS > Exit Application to exit the DIGIOP Server software.  
 
2. When the application closes and the main Microsoft Windows screen appears, click 

the Windows Start button. 
 
3. Click Help and Support. The factory default settings appear.  
 
4. On the left of the window are the Current and Factory Settings.  
 
5. To modify these settings use the drop down menus or enter the data directly in the 

appropriate boxes. 
 
Here is an example of these settings: 

 

Current software version 

Current Image version – must match the motherboard 
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Appendix F. 
File naming conventions 
 
NOTE: Drives A through to F are reserved for the Operating System. 
 
The DIGIOP Server application saves recorded images on the G:/ drive. When the G:/ 
drive is full, images are saved to the H:/ drive. When the H:/ drive is full (or if no H: 
drive exists), images are saved to the I:/ drive, etc.  

Daily directories 

Each day the system runs, the DIGIOP Server application creates a new directory under 
DiSSTech\DiSS. These daily directories are formatted as YEAR-MONTH-DAY, using 
four digits for the YEAR and two digits each for the MONTH and DAY (yyyymmdd).  
 
Example: The directory called 20051124 is for November 24, 2005. 
 
• YEAR = 2005 
• MONTH = 11 (November) 
• DAY = 24 
 

Hourly files 

In each daily directory, the application stores video files each hour. These are encrypted 
.DSP and index (.INX) files for that day. The .DSF file can be viewed using a DIGIOP 
utility, e.g., DIGIOP Viewer or DIGIOP Remote Manager. 
 
These hour files are in the format HOUR (24 hours)–MINUTE–SECOND–CAMERA 
CODE, using two digits each (hhmmsscc). 
 
Example: The file called 10553103.DSF is the hourly video file for the .INX and .DSF 
files in directory 20060105. 
 
• HOUR = 10 (AM) 
• MINUTE = 55 minutes 
• SECOND = 31 
• CAMERA CODE = Camera 4 

(Camera 1 is 00, Camera 2 is 01, 
Camera 3 is 02, etc.) 

 
These files are typically recorded 
immediately after each hour ends. 
The video file size changes 
significantly based on the recording 
modes (e.g., motion versus 
continuous) and compression type. 
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Day File 
yyyymmdd 

Hour long encrypted video file 
hhmmsscc* 

*cc = camera number 

Audio/Video 
Data 
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Appendix G. 
TCP/IP port settings using the firewall 
If there is a firewall between the DVR and the PCs on remote sites running the DIGIOP 
Remote Manager software, you must open ports to allow communications.  
 
Table G-1 contains TCPIP port settings: 
 
 

Table G-1 
TCP/IP Port Settings 

TCP/IP Port (TCP)* 

Log-in connection 7000 

Transmission for live viewing 8000, 8001 

Transmission for remote playback (VOD) 9000, 9001 

Connection for server diagnosis 8002 

Transmission for alarmed video notification 8003 

Time synchronization 3000 

SMTP for email event notification 25 

Two-Way Audio 7021 

Event notification 8875 (UDP) 

 *Each port number is fixed 

 Multicast protocol port, IP = 230.255.255.255 

 
Table G-2 lists the ports that you need to forward through a router. 
 

Table G-2 
Router Ports Forwarded 

 Ports  Forward 
Logon 7000  TCP Yes 
Live transmission 8000, 8001  TCP Yes 
Checking Server 8002  TCP Yes 
Alarm input 8003  TCP Yes 
VOD transmission 9000, 9001  TCP  Yes 
Time Sync 3000  TCP  Yes 
Two-Way Audio 7021  TCP  Yes 
Event Notification 8875  UDP Yes 
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Appendix H. 
Troubleshooting 

Unit does not power up 
WARNING: To avoid personal injury or damage to the equipment, make sure the rack that the 
Rack Mount Chassis is mounted in is reliably earth grounded. 
Consideration should be given to the connection of the equipment to the supply circuit and the 
effect that overloading of circuits could have on overcurrent protection and supply wiring. 

Questions to ask beforehand (to help find root cause of issue) 

• Was the unit working beforehand? If so, for how long? 
• Did anything happen that may have caused this (lightning strike, power failure)? 
• Is this unit on a UPS? If so, is it on the power protected side and not the surge side? 

Troubleshooting Questions/Suggestions 
CAUTION: This installation should be performed only by a qualified 
service person; it should conform to all municipal codes. 
 
• Verify that the power lead going into the system is live.  
• Check that the power switch is turned On. 
• Visually inspect whether the LEDs are on and that the power supply and CPU fans 

are operating. 
• Switch the power cord to another outlet. 
• Switch to another power cord. 
• Open the cover to check voltages with a voltmeter on the power supply. These should 

be 12v and 5v. 
• Inspect the main board for bulging capacitors. 
• Check the processor heat sink and make sure it is properly installed. 
• Check and make sure the voltage input is set to its proper setting, which in most cases 

is 115 V. If the unit is shipped overseas or to some Latin American countries, you 
may need to set the switch 230V. Check the power requirements for the country in 
which you are operating the unit. 

• If all steps have been followed and problem cannot be solved in the field, DIGIOP 
Technical Support will issue a help desk ticket and instructions to send the unit for a 
Return to Depot Repair. 

• (G3 systems only) — Check the diagnostic lights for hardware reference. Boot the 
system with the Recovery CD in the drive. Go into the Tools area and then the 
Diagnostics (Dells Only), check whether the hard drive detects any problems, if not 
try another power connector.  

• (G3 systems only) DIGIOP Technical Support will have to open a trouble ticket with 
Dell or HP and possibly dispatch an onsite technician in coordination with the 
servicing dealer. Or, a replacement part may be sent. 
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Auto Reboot occurs when the DIGIOP Server is running 

Unit auto reboots from within the DIGIOP Server software 

• Check all camera signals. The voltage should be 1.0 - 1.5 volts from peak to peak. 
• Make sure the capture card is detected by the unit and that the drivers are properly 

installed. 
• Unplug all camera signals from the system and monitor for up to several hours. 
• Check the Event Log for references to the root cause of the error. 
• Check the Microsoft Windows Event Viewer for the root cause of the error. 
• Perform a factory field recovery in case this is caused by software corruption. 
• Check the memory module(s) and make sure it is properly seated. Uninstall and 

reinstall it. If there are multiple modules, remove each and test each individually. 
• Perform Western Digital® Data Lifeguard Tools with the option to write zeros to the 

drive (located on Recovery Media of version 6.10.2 and above). 
• If all steps have been followed and problem cannot be solved in the field, DIGIOP 

Technical Support will issue a help desk ticket and instructions to send the unit for a 
Return to Depot Repair. 

Auto Reboot occurs before the DIGIOP Server launches 

Unit reboots before loading Windows and or the DIGIOP Server software 

• If unit reboots after completing POST (power on self test), the problem could be in 
the hardware, memory, hard disk, and or motherboard. A DIGIOP Technical Support 
will issue a help desk ticket and instructions to send the unit for a Return to Depot 
Repair. 

• If the unit loads Windows and reboots when attempting to load DIGIOP, check 
Microsoft Windows System Device manager for conflicts with device drivers. Re-
install driver(s), as needed. 

• Load the BIOS update from the Recovery disk. 
• Perform field recovery with the factory setting options. 
• If all steps have been followed and problem cannot be solved in the field, DIGIOP 

Technical Support will issue a help desk ticket and instructions to send the unit for a 
Return to Depot Repair. 

 

Unit powers on then shuts off 
The unit powers on, but only stays on for about 3 to 4 seconds before it shuts off. 
• Check the heat sink and the processor. Make sure all the latches are secured and the 

CPU is properly installed. 
• Make sure the processor has the correct amount of heat sink solution (thermal grease) 

between the heat sink and the processor. 
• Check the memory module(s) and make sure it is properly seated. Uninstall it and 

reinstall. If there are multiple modules take each one out and test each individually. 
• Check all power cables coming from the power supply. 
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• Check voltages coming from power supply; these should be 12v and 5v. 
• If all steps have been followed and the problem cannot be solved in the field, DIGIOP 

Technical Support can issue a help desk ticket and instruct to send in for Return to 
Depot Repair.  

• (G3 Dell systems only) Check the Dell diagnostic lights for the associated hardware 
reference (see Table H-4 in the DIGIOP G3 Service Guide). If more assistance is 
required, DIGIOP Technical Support must open a trouble ticket with Dell or HP and 
possibly dispatch an onsite technician in coordination with the servicing dealer. A 
replacement part may also be sent.  
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Appendix I. 
Recovering a lost password 
 
If an administrative password is lost, this procedure lets you reset the password. 
 
1. Attach a keyboard to the system. You must have an external keyboard to perform this 

procedure.  
 
NOTE: If you need to attach a PS2 keyboard, (1) shut down the system, (2) attach the keyboard, 
and then (3) restart the system. 
 
2. Enter the following keystrokes in this order, holding each key until released: 

  
 

Press and hold Shift+ALT and then press 0 (and release) and then 9 (and release). 
 

This exits DIGIOP. 
 
3. Turn off Netbackup agent and open Windows Explorer. See Appendix A, “DIGIOP 

System Tray programs” for information about turning off the NetBackup Agent. 
 
4. Open the D: drive and navigate to Disstech\DiSS and find the dissuserlist.ini file. 
 
5. Delete the dissuserlist.ini file. 
 
6. Restart DIGIOP (from the Start menu).  
 
7. When you are prompted to enter a new password for the admin user, LEAVE THE 

PASSWORD FIELD BLANK. 
 
8. Click OK. The DIGIOP Server software launches. 
 
9. Go into Tools > Configure. 
 
10. Set passwords for each user. 
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Appendix J. 
DIGIOP Contact Information 
To contact DIGIOP Technologies, Inc., go to the Support page of the DIGIOP website at 
www.digiop.com/support      

  

Select the appropriate telephone number: 
• 800.968.3606 Toll Free 
• 713.333.4900  
 
 



   

64                                                                                                                                DIGIOP G3 User Guide 

Appendix K. 
Warranty 
Warranty information about your DIGIOP system may be found on the DIGIOP website 
at www.digiop.com/support. From the drop-down list, select Warranty Information.



 

DIGIOP G3 User Guide                                                                                                                                65  

 
.DSF 

directory, 57 
format, 31 
saving files, 43 
viewer, 43 

.INX files, 57 

.JPEG, 32, 42 
4CIF images, 34 
A, audio mark, 12 
activate. See license 
admin, 16 
APP window, 37 
audio, 22, 52 

connectors, 11 
line out, 12 

audio input, 12 
auto log off, 18 
auto-recovery, 12 
backup, 43 
Backup window, 43 
BIOS, 53 
Block, 40 
calendar 

search for recording, 29 
camera 

Camera Inputs, 12 
CDs, in package, 10 
Channel Input, 36 
clock, setting, 23 
CMOS, 53 
continuous C record mode, 22 
copying still images, 32 
copying video, 31 
Current and Factory Settings, 56 
daily directories, 57 
Data Transaction Manager, 48 
Deinterlace, 34 
DIGIOP logo information, 22 
DIGIOP Server software 

about, 14 
DIGIOP Transaction Manager. See also 

Point of Sale, Data Transaction 
Manager 

disk space, 45, 53 
DiSS, 63 

Disstech, 63 
DissTech, 51, 52 
dissuserlist.ini, 63 
dissuserlist.ini file, 63 
drive partitions, 51, 52 
drivers, 51 
DSF video/audio data files location, 52 
DTM, 48 
DVR serial number, 56 
dwell time, 21 
email 

SMTP, 59 
Enterprise Surveillance Portal, 9 
ESP. See Enterprise Surveillance Portal 
event log, 25, 47 
exit DIGIOP, 49 
Exit DIGIOP, 17, 25 
fast forward video control, 30 
file naming conventions, 57 
firewall, 59 
forgotten password, 16 
FPS, 25 
full screen, 21, 24 
Graphical Record Log, 28 
hard drive, 51 

Pause Recording, 18 
recovery CD, 53 

HDD, 36, 45, 53 
Hour Backup, 43 
HOUR BACKUP, 28 
hourly files, 57 
image 

backup location, 52 
version on system, 56 

installer user account, 16 
Interlace, 34 
IP address, 20 
license 

ESP, 25 
file location on drive, 52 
ID, 54 
POS, 25 

License ID, 54 
log files location, 52 
Log Out, 16 
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Log Out button, 17 
login, 15 
lost password, 63 
MAC address, 55 
main screen, 15 
Main screen, 20 
manager user account, 16 
model number, finding, 22 
Monitor Outputs, 12 
motion 

M record mode, 22 
MPEG, 8, 28, 33 
MPEG video, 33 
multi- screen, 24 
multi-screen, 21 
Museum Search. See Smart Search 
NetBackup  Agent 

recovering lost password, 63 
NetBackup Agent, 51 

importance of, 49 
shutting down, 50 
system tray, 49 

Odd & Even fields, 34 
PAL, 8 
password, 16, 17, 63 

default, 15 
forgotten, 16 
lost, 63 
recovery, 63 

pause 
Pause Recording, 18 

Pause Recording menu, 18 
Playback Controls, and search, 27 
playback speed, 27 
playback speed video control, 30 
Point of Sale. See also Data Transaction 

Manager 
port 

LAN, 12 
Mouse, 11, 12, 13 
multicast protocol, 59 
router, 59 
USB, 12, 13 

POS, 48, See Point of Sale 
Post Processed, 36 
power, 14 

power up system, 14 
printer, 17, 45 
PTZ, 22 

RS-232 cable, 10 
Quick Search 

for Smart Search, 40 
recovery mode, 49 
relay, 22 
Relay Outputs, 12 
Remote Login, 47 
Remote Manager, 9, 47, 57, 59 
Restart DIGIOP menu, 19 
rewind, 30 
router 

ports, 59 
troubleshooting, 59 

Safely, 50 
scan bar, 28 
S-Class, 28, 34 
search 

calendar, 27 
Playback Controls, 27 
screen division, 27 
Smart Search, 41 
time line, 27 
Tools, 27 

Search main window, 26 
Search Sensor Events, 44 
Search Tools, 27 

Image Post Processing, 35 
list of, 35 

searching, how to, 29 
security user, 16 
Sensitiveness setting 

for Smart Search, 40 
sensor, 21 
sensor input, 12, 22 
serial number, locating on DVR, 56 
shut down 

abnormal, 18 
disconnecting mains, 18 
OS, 18 
power button, 18 
safeguards, 18 

Shut Down button, 17 
Smart Search, 38 
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controls, 41 
next movement, 42 
options, 42 
save, 42 
setting up, 38 
slide control, 42 
Zoom, 42 

Square, 40 
step forward video control, 30 
sub-D connector, 12 
System Recovery DVD/CD:, 53 
System Tray 

hardware removal, 49 
NetBackup Agent, 49 

system, powering up, 14 
TCPIP port settings, 59 

timeline, and searching, 29 
troubleshooting, 60 
USB device, 50 
User Codes for licensing, 54 
username, 15, 16, 17 
V, video mark, 12 
Version Info, 22 
video 

cables, 10 
connectors, 11 
controls used to search, 30 

volume control, 45 
Windows OS location, 52 
Windows XPE, 14 
zoom, 28, 31 

 


